
INSTALLATION INSTRUCTIONS

NI SCXI -1331
Terminal Block for the NI SCXI-1127/1128

This guide describes how to install and connect signals to the 
National Instruments SCXI-1331 terminal block to configure the 
SCXI-1127/1128 switch module as a 64 × 1, 1-wire matrix, a 32 × 1, 
2-wire matrix, or a 16 × 1, 4-wire matrix.

Screw terminals on the SCXI-1331 allow you to access the matrices. 
The SCXI-1331 also contains terminals for external trigger signals.

Refer to the NI Switches Getting Started Guide to determine when to install 
the terminal block. Visit ni.com/switches for information on other 
switching solutions.

Conventions
The following conventions are used in this guide:

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 
avoid injury, data loss, or a system crash. When this symbol is marked on 
a product, refer to the Read Me First: Safety and Radio-Frequency 
Interference document for information about precautions to take.

bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options. Bold text also denotes parameter 
names.

™
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italic Italic text denotes variables, emphasis, a cross reference, or an introduction 
to a key concept. This font also denotes text that is a placeholder for a word 
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 
keyboard, sections of code, programming examples, and syntax examples. 
This font is also used for the proper names of disk drives, paths, directories, 
programs, subprograms, subroutines, device names, functions, operations, 
variables, filenames and extensions, and code excerpts.

1. Unpack the Terminal Block
To avoid damage in handling the terminal block, take the following 
precautions:

Caution Never touch the exposed pins of connectors. 

• Ground yourself using a grounding strap or by touching a grounded 
object.

• Touch the antistatic package to a metal part of your computer chassis 
before removing the terminal block from the package.

Remove the terminal block from the package and inspect the terminal block 
for loose components or any sign of damage. Notify NI if the terminal 
block appears damaged in any way. Do not install a damaged terminal 
block into your system.

Store the SCXI-1331 in the antistatic envelope when not in use.
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2. Verify the Components
Make sure that you have the following items:

❑ SCXI-1331 terminal block

❑ SCXI chassis

❑ SCXI-1127 or SCXI-1128 switch module

❑ 1/8 in. flathead screwdriver

❑ Numbers 1 and 2 Phillips screwdrivers

❑ Long-nose pliers

❑ Wire cutter

❑ Wire insulation stripper

3. Connect Signals
To connect the signal(s) to the terminal block, refer to Figures 1 and 2 
while completing the following steps:

1. Prepare the signal wire by stripping the insulation no more than 7 mm 
from the end of the wire.

2. Remove the top cover screw.

3. Unsnap and remove the top cover.

4. Loosen the two strain-relief screws on the strain-relief bar.

5. Run the signal wires through the strain-relief opening.

6. Insert the stripped end of the wire fully into the terminal. Secure the 
wire by tightening the screw of the terminal. No bare wire should 
extend past the screw terminal. Exposed wire increases the risk of a 
short-circuit causing a failure.

7. Connect the safety earth ground to the safety ground lug.

8. Tighten the two screws on the strain-relief assembly to secure the 
cables.

9. Reinstall the top cover.

10. Replace the top cover screw.
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Figure 1.  SCXI-1331 Top Cover Diagram

1 Top Cover Screw 2 Top Cover

2

1
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Figure 2.  SCXI-1331 Parts Locator Diagram

4. Install the Terminal Block
To connect the SCXI-1331 to the SCXI-1127/1128 front connector, 
complete the following steps:

1. Plug the SCXI-1331 onto the front connector on the SCXI-1127/1128.

2. Tighten the top and bottom thumbscrews on the terminal block rear 
panel to hold it securely in place.

1 Multiplexer Outputs
2 2-Wire Mode Channel Numbering
3 4-Wire Mode Channel Numbering
4 1-Wire Mode Channel Numbering
5 Thumbscrews

6 Rear Connector
7 Strain-Relief Bar
8 Strain-Relief Screw
9 Safety Ground Lug

1 2 43 5
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8

7
6
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Note For accurate cold-junction compensation, place the SCXI chassis away from an 
extreme temperature differential.

Figure 3.  Installing the SCXI-1331 Terminal Block

1 SCXI-1331 Thumbscrew
2 SCXI-1127/1128 Thumbscrews

3 Front Connector
4 SCXI-1127/1128

5 SCXI-1331

2

1

3

4

5



© National Instruments Corporation 7 NI SCXI-1331 Installation Instructions

5. Use the Temperature Sensor Output
The temperature sensor output is a thermistor that is located near the 
J5 connector on the underside of the PCB. The SCXI-1331 temperature 
sensor outputs 0.2 V to 0.024 V from 0 °C to 50 °C, and it has an accuracy 
of ±0.5 °C over the 15 °C to 35 °C range and an accuracy of ±0.9 °C over 
the 0 °C to 15 °C and 35 °C to 50 °C ranges.1

NI software can convert a thermistor voltage to the thermistor temperature 
for the circuit diagram shown in Figure 4. 

Figure 4.  Temperature Sensor Circuit Diagram

In LabVIEW, use the Convert Thermistor Reading VI in the Data 
Acquisition»Signal Conditioning palette. If you are using 
LabWindows™/CVI™ or NI-DAQ, use the Thermistor_Convert 
function. This function takes the output voltage of the temperature sensor, 
the reference voltage (2.5 V), and the precision resistance (189 kΩ) and 
returns the thermistor temperature.

1   Includes the combined effects of the temperature sensor accuracy and the temperature difference between the temperature 
sensor and any screw terminal. The temperature sensor accuracy includes tolerances in all component values, the effects 
caused by temperature and loading, and self-heating.

4.7 kΩ 
1%

189 kΩ 
0.1%

CJTEMP
1

2

1

2

2

+5 kΩ 
at 25o C

10 µF
16 V

0.1 µF

0.1 µF

–t 

o

+5 V

2.5 V

LM 4040
2.5 V
0.1%
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Alternatively, you can use the following formulas:

T(°C) = TK – 273.15

where TK is the temperature in Kelvin,

where a = 1.295361 × 10–3,
b = 2.343159 × 10–4,
c = 1.018703 × 10–7, and
RT = resistance of the thermistor in ohms,

where VTEMPOUT is the output voltage of the temperature sensor,

where T(°F) and T(°C) are the temperature readings in degrees 
Fahrenheit and degrees Celsius, respectively.

Specifications

Cold-Junction Sensor
Accuracy1

From 0 °C to 15 °C..........................±0.9 °C

From 15 °C to 35 °C........................±0.5 °C

From 35 °C to 50 °C........................±0.9 °C

Output

From 0 °C to 50 °C..........................0.2 V to 0.024 V

1   Includes the combined effects of the temperature sensor accuracy and the temperature difference between the temperature 
sensor and any screw terminal. The temperature sensor accuracy includes tolerances in all component values, effects caused 
by temperature, loading, self-heating, and temperature gradients.

TK
1

a b RTln( ) c RTln( )3+ +[ ]
---------------------------------------------------------------=

RT 189 000
VTEMPOUT

2.5 VTEMPOUT–
----------------------------------⎝ ⎠
⎛ ⎞,=

T °F( ) T °C( )[ ]9
5

---------------------- 32+=
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Maximum Voltage
Channel-to-ground ................................. 300 V, CAT II

Caution This module is rated for Measurement Category II and intended to carry signal 
voltages no greater than 300 V. This module features 1390 Vrms isolation between input 
signals and the chassis as verified by a dielectric withstand test, 1 minute maximum. Do not 
use this module for connection to signals or for measurements within Categories III or IV. 
Refer to the Read Me First: Safety and Radio-Frequency Interference document for more 
information about measurement categories.

Maximum Current
Maximum current
(per channel) .......................................... 2 ADC, 2 AAC

Environment
The NI SCXI-1331 is intended for indoor use only.

Operating temperature............................ 0 °C to 50 °C

Storage temperature ............................... –20 °C to 70 °C

Relative humidity ................................... 10% to 90% RH, noncondensing

Pollution Degree .................................... 2

Approved at altitudes up to 2,000 m.

Safety
This product is designed to meet the requirements of the following 
standards of safety for electrical equipment for measurement, control, 
and laboratory use:

• IEC 61010-1, EN 61010-1

• UL 61010-1

• CAN/CSA-C22.2 No. 61010-1

Note For UL and other safety certifications, refer to the product label or visit 
ni.com/certification, search by model or product line, and click the appropriate link 
in the Certification column.



NI SCXI-1331 Installation Instructions 10 ni.com

Electromagnetic Compatibility
Emissions................................................EN 55011 Class A at 10 m

FCC Part 15A above 1 GHz

Immunity ................................................EN 61326:1997 + A2:2001, 
Table 1

CE, C-Tick, and FCC Part 15 (Class A) Compliant

Note For EMC compliance, operate this device with shielded cabling.

CE Compliance
This product meets the essential requirements of applicable European 
Directives, as amended for CE marking, as follows:

Low-Voltage Directive (safety)..............73/23/EEC

Electromagnetic Compatibility 
Directive (EMC) .....................................89/336/EEC

Note Refer to the Declaration of Conformity (DoC) for this product for any additional 
regulatory compliance information. To obtain the DoC for this product, visit 
ni.com/certification, search by model number or product line, and click the 
appropriate link in the Certification column.



 

National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. Refer to the Terms of Use section on 
ni.com/legal for more information about National Instruments trademarks. Other product and company names mentioned herein are 
trademarks or trade names of their respective companies. For patents covering National Instruments products, refer to the appropriate location: 
Help»Patents in your software, the patents.txt file on your CD, or ni.com/patents.

© 1998–2007 National Instruments Corporation. All rights reserved. 372337E Nov07



取り付け手順

NI SCXI –1331
NI SCXI–1127/1128 用端子台

このガイドでは、ナショナルインスツルメンツ製 SCXI–1331 端子台の取

り付けおよび信号接続、そして SCXI–1127/1128 スイッチモジュールを

単線式 64 × 1 マトリクス、2 線式 32 × 1 マトリクス、または 4 線式

16 × 1 マトリクスとしての構成方法について説明します。

SCXI–1331ではネジ留め式端子を使用してマトリクスにアクセスします。 
また、外部トリガ信号用の端子も装備しています。

端子台を取り付ける順番については、『NI スイッチスタートアップガイド』

を参照してください。 スイッチモジュールについての詳細は、ni.com/

switches（英語）を参照してください。

表記規則

このドキュメントでは、以下の表記規則を使用します。

→ 矢印（→）は、ネスト化されたメニュー項目やダイアログボックスのオプ
ションをたどっていくと目的の操作項目を選択できることを示します。 た
とえば、ファイル→ページ設定→オプションとなっている場合は、ファイ
ルメニューをプルダウンして、ページ設定項目を選択し、最後のダイアロ
グボックスからオプションを選択します。

このアイコンは、注意すべき重要情報があることを示します。

このアイコンは、負傷、データの損失、システムの破損を防止するための
注意事項を示します。 製品にこの記号が付いている場合は、事前対策につ
いて 『はじめにお読みください：安全対策と無線周波数妨害について』
を参照してください。

太字 太字のテキストは、メニュー項目やダイアログボックスのオプションな
ど、ソフトウェアで選択またはクリックする必要がある項目を表します。 
また、太字のテキストは、パラメータ名も表します。

斜体 斜体のテキストは、変数、強調、相互参照または重要概念の説明を示しま
す。 また、入力する必要のある文字列や値を表すこともあります。

™
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monospace このフォントのテキストは、キーボードから入力する必要があるテキスト
や文字、コードの一部、プログラムサンプル、構文例を表します。 また、
ディスクドライブ、パス、ディレクトリ、プログラム、サブプログラム、
サブルーチンなどの名称、デバイス名、関数、操作、変数、ファイル名お
よび拡張子、コードの引用にも使用されます。

1. 端子台を箱から取り出す

取り扱い中に端子台を破損しないために、以下の予防措置を行ってくださ

い。

注意 露出しているコネクタピンには絶対に触れないでください。 

• 接地ストラップを使用したり、接地されている物体に触れて、身体を

接地する。

• 静電気防止用パッケージをコンピュータシャーシの金属部分に接触さ

せてから、端子台をパッケージから取り出す。

端子台を箱から取り出し、部品がゆるんでいないかどうか、また、破損箇

所がないかどうか調べます。 端子台が破損している場合は、ナショナル　

インスツルメンツまでご連絡ください。 破損している端子台をシステムに

取り付けないでください。

SCXI–1331 は、使用しない時は静電気防止用パッケージに入れて保管し

てください。
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2. 部品を確認する

下記の部品があることを確認します。

❑ SCXI–1331 端子台

❑ SCXI シャーシ

❑ SCXI–1127 または SCXI–1128 スイッチモジュール

❑ 1/8 in. マイナスドライバー

❑ 1 番および 2 番のプラスドライバー

❑ ラジオペンチ（先細）

❑ ワイヤカッター

❑ ワイヤストリッパー

3. 信号を接続する

信号を端子台に接続するには、図 1 および図 2 を参考に次の手順に従い

ます。

1. 信号線の端から 7 mm 以内の部分だけ絶縁被覆を取り除きます。

2. 上部カバーのネジを外します。

3. スナップを外して上部カバーを取り外します。

4. ストレインリリーフバーにある 2 つのストレインリリースネジを緩

めます。

5. 信号線をストレインリリーフの開いた部分に通します。

6. ワイヤの裸線部分を端子に挿入します。 端子に付いているネジを締め

てワイヤを固定します。 裸線がネジ留め式端子の外に露出しないよう

に注意してください。 ワイヤが露出しているとショートする可能性が

あり、正しく作動しない場合があります。

7. アースを安全接地用圧着端子に接続します。

8. ストレインリリーフアセンブリの 2 つのネジを締めて、ケーブルを

固定します。

9. 上部カバーを取り付けます。

10. 上部カバーのネジを取り付けます。
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図 1 SCXI–1331 上部カバー

1 上部カバー用ネジ 2 上部カバー

2

1
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図 2 SCXI–1331 の部品位置

4. 端子台を取り付ける

SCXI–1127/1128 のフロントコネクタに SCXI–1331 を接続するには、次

の手順に従います。

1. SCXI–1331 を SCXI–1127/1128 のフロントコネクタに差し込みます。

2. 端子台の後部パネルにある上下のつまみネジを締めて、端子台をしっ

かりと固定します。

1 マルチプレクサ出力

2 2 線式モード時のチャンネル番号

3 4 線式モード時のチャンネル番号

4 単線式モード時のチャンネル番号

5 つまみネジ

6 後部コネクタ

7 ストレインリリーフバー

8 ストレインリリーフネジ

9 接地用圧着端子

1 2 43 5

9

8

7
6

5
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メモ 正確な冷接点補償を行うには、SCXI シャーシを極端な温度差のある環境から遠

ざけます。

図 3 SCXI–1331 端子台を取り付ける

1 SCXI–1331 つまみネジ

2 SCXI–1127/1128 つまみネジ
3 フロントコネクタ
4 SCXI–1127/1128

5 SCXI–1331

2

1

3

4

5
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5. 温度センサ出力を使用する

温度センサ出力は PCB 底部の J5 コネクタ付近にあるサーミスタです。 
SCXI-1331 温度センサ出力は、0.2 V ～ 0.024 V（0 ℃ ～ 50 ℃時）で、確

度は 15 ℃ ～ 35 ℃の範囲で ±0.5 ℃、0 ℃ ～ 15 ℃および 35 ℃ ～ 50 ℃の

範囲で ±0.9 ℃になります。1

NI のソフトウェアを使用すると、図 4 に示す回路図におけるサーミスタ

電圧をサーミスタ温度に変換することができます。 

図 4 温度センサ回路図

LabVIEW では、データ集録→信号調節パレットで「サーミスタ読み取り

値の変換」VI を使用します。 LabWindowsTM/CVITM または NI–DAQ をお

使いの場合は、「Thermistor_Convert」関数を使用します。 この関数で

は、温度センサ、基準電圧（2.5 V）、および精密抵抗（189 kΩ）の出力

電圧を取り込んで、サーミスタ温度を返します。

1   温度センサとネジ留め式端子間の温度センサ確度および温度差における両方の影響を含みます。 温度センサ確度には、すべての

部品の耐性、温度と負荷による影響、および自己発熱が含まれます。

4.7 kΩ 
1%

189 kΩ 
0.1%

CJTEMP
1

2

1

2

2

+5 kΩ 
(25

10 µF
16 V

0.1 µF

0.1 µF

–t 

o

+5 V

2.5 V

LM 4040
2.5 V
0.1%
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その他の方法として、次の式を使用できます。

T( ℃ ) = TK – 273.15

 TK は、ケルビン温度を示します。

a = 1.295361 × 10–3

b = 2.343159 × 10–4

c = 1.018703 × 10–7

RT = サーミスタの抵抗（Ω）

 VTEMPOUT は温度センサの出力電圧を示し

ます。

 T（°F）および T（℃）はそれぞれ華氏と

摂氏で表した温度です。

仕様

冷接点センサ
確度1

0 ℃ ～ 15 ℃ ............................................ ±0.9 ℃

15 ℃ ～ 35 ℃ ......................................... ±0.5 ℃

35 ℃ ～ 50 ℃ ......................................... ±0.9 ℃

出力

0 ℃ ～ 50 ℃ ............................................ 0.2 V ～ 0.024 V

1   温度センサとネジ留め式端子間の温度センサ確度および温度差における両方の影響を含みます。 温度センサ確度には、すべての

部品の耐性、温度と負荷による影響、自己発熱、および温度変動が含まれます。

TK
1

a b 1nRT( ) c 1nRT( )3+ +[ ]
-----------------------------------------------------------------------=

RT 189 000
VTEMPOUT

2.5 VTEMPOUT–
---------------------------------------⎝ ⎠
⎛ ⎞,=

T °F( ) T °C( )[ ]9
5

------------------------ 32+=
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最大電圧
チャンネル / グランド間.............................. 300 V、CAT II

注意 このモジュールは Measurement Category II に準拠し、300 V 未満の信号電

圧を許容するように設計されています。また、このモジュールは、誘電耐性試

験で検証されるように、入力信号およびシャーシ間にて最大 1 分間 1390 Vrms
の絶縁を提供します。 Category II、III、または IV の信号を、このモジュールに

接続したり測定しないでください。 Measurement Category についての詳細

は、 『はじめにお読みください：安全対策と無線周波数妨害について』を参照し

てください。

最大電流
最大電流
（チャンネルあたり）...................................... 2 ADC、2 AAC

環境
NI SCXI–1331 は、屋内での使用を意図して設計されています。

動作温度 ............................................................ 0 ℃ ～ 50 ℃

保管温度 ............................................................ –20 ～ 70 ℃

相対湿度 ............................................................ 10 ～ 90% （結露なきこと）

汚染度................................................................. 2

最高 2,000 m の高度で認証済み。

安全性
この製品は、計測、制御、実験に使用される電気装置に関する以下の安全

規格の必要条件を満たすように設計されています。

• IEC 61010–1、EN 61010–1
• UL 61010–1

• CAN/CSA–C22.2 No. 61010–1

メモ UL および他の安全保証については、製品のラベルを参照するか、ni.com/ 

certification（英語）にアクセスして型番または製品ラインで検索し、保証

の欄の該当するリンクをクリックしてください。



NI SCXI–1331 取り付け手順 10 ni.com/jp

電磁両立性
エミッション .................................................... EN 55011 Class A (10 m) 

FCC パート 15A (1 GHz 以上 )

イミュニティ（電磁環境耐性）................... EN 61326:1997 + A2:2001、
Table 1

CE、C–Tick、FCC Part 15（Class A）準拠

メモ EMC に適合させるには、このデバイスをシールドケーブルと一緒に使用してく

ださい。

CE 適合
この製品は、以下のように、CE マーク改正に基づいて、該当する EC 理

事会指令による基本的要件に適合しています。

低電圧指令（安全性）.................................... 73/23/EEC

電磁両立性 
規格（EMC）..................................................... 89/336/EEC

メモ この製品のこのほかの適合規格については、この製品の適合宣言（DoC）を参

照してください。 この製品の適合宣言を入手するには , ni.com/certification
（英語）にアクセスして型番または製品ラインで検索し、保証の欄の該当するリ

ンクをクリックしてください。
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